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RESOLUTION:
=============
Operating system considerations for a multilingual installation of Office
The Microsoft Windows 2000 and Microsoft Windows XP operating systems both
support international features of Microsoft Office 2003. In some cases, you
may need to set a specific system locale for Office to support the desired
language.

Office 2003 automatically enables languages for editing when the languages
are enabled in Windows 2000 and Windows XP. However, Windows XP enables
some languages in groups — complex script languages and East Asian
languages — that Office 2003 does not enable as groups automatically. If
you want to enable complex script or East Asian languages for editing with
Office on Windows XP, you must enable them manually in Office.
−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−

−−−−
Toolbox   Information about limitations for language support is included in 
the Microsoft Office Excel 2003 workbook Wwsuppt.xls, which is installed by 
default when you run the Microsoft Office Resource Kit Setup program. For 
more information, see International Information in the Toolbox.
−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−
−−−−
Displaying the user interface in other languages
Windows 2000 and Windows XP provide support for all possible Office user 
interface languages. You need to ensure a user's system locale (which 
governs the code page of the user's computer) is set to a locale that 
supports the primary language the user needs. 
The system locale that you set depends on the primary language your users 
need. This is because some code pages provide support for groups of 
languages; other code pages provide support for only a single language. For 
example, if your users work primarily in Japanese, set their system locale 
to Japanese. If your users work primarily in French, their system locale 
can be any Western European system locale.
For some applications and features in Office 2003, the native code page of 
the operating system must support the user interface language. For these 
applications and features, text in the user interface — such as file names 
in Microsoft Office FrontPage® 2003 — must be supported by the operating 
system's system code page.
When you use FrontPage 2003 and some features (such as Microsoft Visual 
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Basic® for Applications) you can change the user interface language to any 
language that is supported by the system code page of your operating 
system. When you change the user interface to a language that does not have 
code page support, FrontPage displays the user interface in English.
−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−
−−−−
Toolbox   Some Office features do not change when you change the language 
of the user interface or Help. Information about those features is 
available in the Microsoft Excel workbook Intlimit.xls, which is installed 
by default when you run the Office Resource Kit Setup program. For more 
information, see International Information in the Toolbox.
−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−
−−−−
Displaying Help and Microsoft Office Online assistance in other languages
Microsoft Office Online, the site on the World Wide Web for end users of 
the Microsoft Office System, consists of a number of international sites 
containing appropriate content for the local language, country, or region. 
These international sites represent the majority of languages in which 
Office 2003 and the Microsoft Office 2003 Multilingual User Interface Packs 
are available. 
Initially, the language of the Microsoft Office Online Web site is 
determined by Microsoft Internet Explorer language settings. Users can view 
different language−specific and region−specific content on Microsoft Office 
Online, however, by clicking Office Worldwide and choosing a different 
international site. If their Web browser settings allow persistent cookies, 
the new international site persists the next time they visit Microsoft 
Office Online.
The Help language setting in Office applications is handled separately. 
When a user enters a query in an Office application, both online and 
offline query results are always displayed in the language set for Help 
(for users with Microsoft Office 2003 Multilingual User Interface Packs) or 
the installation language of the product (for localized versions of 
Office). For some languages, including English, French, and Chinese, the 
regional settings in Windows also result in content specific to that region.
Because users can change the international site of Microsoft Office Online 
independently of their Help or user interface language settings, 
application language settings are not synchronized with the Microsoft 
Office Online international site. In some cases, users may find themselves 
viewing Web pages with a mixture of languages and region−specific content.
Users can ensure that Help queries are returned in the appropriate language 
by following these guidelines: 
To display query results on Microsoft Office Online in a language other 
than the Office installation language or Help language setting, enter the 
query directly on the Microsoft Office Online language−specific or 
region−specific Web site. 
To ensure that query results on Microsoft Office Online are displayed in 
the same language as the client, choose the site that matches the language 
settings on the local computer. 
Editing documents in other languages
All language versions of Windows 2000 and Windows XP support displaying 
documents in all languages. However, in the case of Asian documents, even 
though users can display documents, they might not be able to edit the 
files to include Asian characters without a special editing interface.
Input of Asian characters requires an Input Method Editor (IME). The 
Microsoft Office 2003 Multilingual User Interface Pack provides IMEs for 
Japanese, Korean, Simplified Chinese, and Traditional Chinese. The IMEs 
allow users to input Asian text in Office applications, regardless of the 
language version of their operating system. Microsoft Office 2003 Proofing 
Tools also includes Input Method Editors.
Using the Windows keyboard layout program
Windows 2000 and Windows XP include a keyboard layout program — On−Screen 
Keyboard — that makes it easier for users to type languages not represented 
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on the physical keyboard. Be sure that the language that users want to use 
in the On−Screen Keyboard has been enabled for editing. 
To access the Windows keyboard layout program 
On the taskbar, click Start, and then click All Programs (Windows XP) or 
Start Programs (Windows 2000). 
Click Accessories. 
Click Accessibility. 
Click On−Screen Keyboard. 
The On−Screen Keyboard dialog box is shown, and you can click the keys 
displayed to perform keyboard functions.
Limitations to entering multilingual content in Outlook in ANSI mode
Microsoft Office Outlook® 2003 provides Unicode® support in most scenarios. 
When Outlook is running in Unicode mode, there are no limitations for 
entering content in other languages. There are, however, some scenarios in 
which Outlook will run in ANSI mode instead of Unicode mode. In these 
situations, there are limitations to be aware of.
When Outlook will be in ANSI mode
In certain scenarios, Outlook will run in ANSI mode. Note that Outlook 
Unicode mode only applies for Microsoft Exchange Server configurations.
The scenarios when Outlook does not support Unicode include: 
For POP accounts when the delivery store is an ANSI PST. 
For Microsoft Hotmail®, IMAP, and LDAP accounts. 
Language limitations when Outlook is in ANSI mode
There are two main types of content that users can type in Outlook when in 
ANSI mode: plain text and rich text. Text typed in a plain text area cannot 
be saved and retrieved in a language that is not supported by the default 
code page set on the user's computer. For example, text entered in most 
fields in a Contact entry (such as the contact name or telephone number) is 
plain text. It cannot have special formatting (for instance, bold or 
italics), and it cannot be saved and retrieved in a language that is not 
supported by the default code page.
Other text−entry areas support rich text — for example, the message body of 
an e−mail message. Rich text support is provided in several ways (for 
instance, by using RTF or HTML), and supports formatting, links, and 
similar elements. Rich text areas also support text entry and retrieval for 
languages that are not supported by the default code page on the user's 
computer.

Choosing a Web browser
The Web browser installed on users' computers can affect how well Microsoft 
Office 2003 supports switching to different user interface languages — and 
can also be a factor in whether users can create multilingual Web pages.
Supporting multilingual dialog boxes
Microsoft Internet Explorer 5 or later allows Microsoft Office 2003 
applications to display certain dialog boxes in any user interface language 
that the operating system supports. Dialog boxes such as New and Open from 
the File menu depend on the code page of the operating system to display 
text.
Using Unicode in multilingual Web pages
Unicode allows users to create multilingual Web pages that not only use 
multiple scripts but also produce smaller files that are easy to parse on 
your intranet or the Internet. You need Internet Explorer 5 or later, or 
Netscape Navigator 4.07 or later, for your browser to interpret Unicode Web 
pages. If you want to maintain compatibility with earlier browsers, avoid 
using Unicode.
−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−
−−−−
Note   The Unicode format commonly used on the Internet is called Universal 
Character Set Transformation Format 8−bit (UTF−8). UTF−8 is the only 
Unicode format that is commonly supported by Web browsers and by FrontPage 
Server Extensions from Microsoft.
−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−
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−−−−
You can set Office 2003 applications to save the current HTML document in 
Unicode. 
To save an HTML document in Unicode in Office 2003 
In an Office application that supports this feature (such as Microsoft 
Office Word 2003), on the Tools menu, click Options. 
On the General tab, click Web Options. 
On the Encoding tab, in the Save this document as list, select Unicode 
(UTF−8). 
−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−
−−−−
Note   To save HTML documents in the Unicode format by default, select the 
Always save Web pages in the default encoding check box in the Web Options 
dialog box.
−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−
−−−−
Using Unicode in multilingual URLs
In addition to allowing users to create HTML documents in UTF−8 encoding, 
Office 2003 and Internet Explorer 5 or later can send UTF−8–encoded URLs to 
Web servers.
UTF−8 encoding allows a user to use URLs that include non−ASCII characters, 
regardless of the language of the user's' operating system and browser, or 
the language version of Office. Without UTF−8 encoding, a user's Web server 
must be based on the same code page as that of the user's operating system 
in order for the Web server to interpret non−ASCII URLs. However, for a Web 
server to interpret UTF−8 encoded URLs, the Web server must have UTF−8 
support.
−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−
−−−−
Note   To use UTF−8 encoded URLs, you must have Microsoft Internet 
Information Services (IIS) 4.0 or later or another Web server that supports 
UTF−8.
−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−
−−−
If your organization has code page based Web servers that do not support 
UTF−8, and you have non−ASCII URLs, you should turn off UTF−8 URL encoding 
in Internet Explorer 5. Otherwise, when users try to use a UTF−8–encoded 
URL that includes non−ASCII characters, the code page based Web server that 
does not support UTF−8 cannot interpret the URL.
To prevent sending URLs in UTF−8 encoding 
In Internet Explorer 5 (or later), on the Tools menu, click Internet 
Options. 
In the Internet Options dialog box, click the Advanced tab. 
Under Browsing, clear the Always send URLs as UTF−8 check box. 
Managing fonts for multilingual installations
Microsoft Windows 2000 and Windows XP provide fonts that allow users to 
view and edit documents in different languages and across different 
scripts. These fonts allow users to: 
Display the user interface and Help in various languages. 
Display text in various languages — in an existing document or text that 
you enter — including languages that require Input Method Editors (IMEs). 
When users enable a language in the operating system, the fonts for that 
language are typically installed for them. Big fonts — such as Tahoma® — 
that were previously supplied by Office are now included in Windows.
However, because some fonts provided in Windows XP are not included in 
Windows 2000, Office 2003 also includes several fonts, such as Arial, 
Unicode, and Syriac. To install fonts from Office for your users, you 
configure the feature installation state in the Custom Installation Wizard 
to install the Additional Fonts feature. Note that fonts installed from 
Office do not update any existing Windows fonts.
−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−
−−−
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Choosing the Unicode font
Some documents, such as Microsoft Access data tables, can display only one 
font at a time. But these documents can display multilingual text in more 
than one script if you use the Unicode font. The Unicode font provided by 
Office 2003 allows users to input and display characters across scripts and 
across code pages that support the various scripts.
Installing a Unicode font on users' computers has some disadvantages. 
First, the Unicode font file is much larger than font files based on code 
pages. Second, some characters might look different from their character 
equivalents in code pages. For these reasons, do not use the Unicode font 
as your default font. However, if your users share documents across many 
different scripts, the Unicode font might be your best choice.
−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−
−−−−
Printing documents
Using the international features of Office 2003 in documents creates some 
special requirements for printing. You must ensure that your printers are 
configured for the correct paper size and for font substitution.
Specifying the correct paper size
Many printers allow you to load both A4 and letter−size paper. If users in 
Europe exchange documents with users in the United States, having both A4 
and letter−size paper in your printers accommodates everyone's documents.
Even if your printers are stocked only with the paper commonly used in your 
part of the world, most Office documents are printed with no loss of text. 
Microsoft Word documents and Microsoft Office PowerPoint® 2003 
presentations are automatically scaled to fit the printer's default paper 
size. Microsoft Outlook messages are printed according to locally defined 
default print parameters. Microsoft FrontPage documents are printed 
according to the browser's page layout settings.
−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−
−−−−
Note   For Microsoft Office Publisher 2003 documents, users must open 
documents and manually change the paper size. For Microsoft Office Access 
2003 reports, users must open a report, manually change the paper size, 
close the report, reopen the report, and then print.
−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−
−−−
In some circumstances, you might not want documents scaled to fit the 
printer's default paper size. For example, if your printer has A4 set as 
its default paper size but the printer also has letter−size paper, Word 
cannot detect that both sizes are available. Because the printer can supply 
the correct size paper, you might want to turn off the resizing option that 
is available in Word.
−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−
−−−−
Group Policy Tip   You can use a policy to turn off the Allow A4/Letter 
paper resizing option on the Print tab (Options menu) in Word. Using Group 
Policy, in the Word 2003 policy template (Word11.adm), under Microsoft 
Word11\Tools | Options\Print\Printing options, double−click Allow A4/Letter 
paper resizing. Click the Enabled option button to set the policy, then to 
turn off resizing, clear the check box in the policy. For more information 
about Group Policy, see Managing Users' Configurations by Policy.
−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−
−−−
Setting TrueType fonts to print correctly
To display characters in multiple scripts, Office uses big fonts. In 
addition to being bold or italic, big fonts can also be Cyrillic, Greek, or 
one of several other scripts.
However, big fonts are also TrueType fonts, and many laser printers 
substitute built−in printer fonts when printing documents that use TrueType 
fonts. Built−in printer fonts cannot render text in multiple scripts, so 
characters in other scripts do not print properly.
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For example, your laser printer might substitute its own internal version 
of Arial, which accommodates only Western European characters. Word uses 
the big font version of Arial to display Greek and Russian characters in 
documents, but if users print those documents, the Greek and Russian 
characters are printed as unintelligible Western European character strings.
To work around the problem, set the option in your printer driver to send 
TrueType fonts as graphics.
−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−
−−−−
Tip   Some non−Asian printers cannot properly print Asian documents because 
the size of the Asian font is too large for the printer's memory. You might 
need to install additional memory in these printers.
LINKS:
=====
http://www.microsoft.com/office/ork/2003/four/ch13/IntA04.htm
http://www.microsoft.com/office/ork/2003/four/ch16/IntD04.htm
HTH
This posting is provided "AS IS" with no warranties, and confers no rights. 
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